
Карманные персональные компью�

теры (КПК), коммуникаторы и смарт�

фоны активно входят в жизнь совре�

менных людей. Сочетая в себе множе�

ство полезных функций, таких как ча�

сы, будильник, калькулятор, календарь

с органайзером, справочники, GPS�на�

вигаторы, GPRS�модемы и др., они по�

могают людям организовать своё вре�

мя, быстро произвести расчёты, опера�

тивно найти необходимую информа�

цию, изучать иностранные языки, отп�

равлять и получать электронную почту,

посетить Интернет, развлечься игрой и

т.д. И, конечно же, основным преиму�

ществом для пользователя КПК являет�

ся возможность совершать данные опе�

рации, находясь практически в любом

месте, благодаря компактности и мо�

бильности этих устройств.

КПК могут работать под управлением

различных операционных систем, та�

ких как Palm OS, Symbian, Windows CE

(Pocket PC), которые позволяют разра�

батывать красивые приложения, актив�

но использующие мультимедийные воз�

можности устройства.

В мире создано большое количество

программ для мобильных устройств,

благодаря которым их функциональ�

ность значительно возрастает. Тем не

менее, в жизни очень часто возникают

задачи, для решения которых требуется

специальная программа, которую не�

возможно найти среди существующих.

В этом случае требуется создание но�

вой программы.

Рассмотрим методику создания прог�

рамм для КПК и смартфонов с самой

распространённой операционной сис�

темой Windows CE, разновидности кото�

рой имеют названия Windows Mobile

различных версий и Pocket PC. Отличи�

тельной чертой Windows CE является

поддержка фонтов Microsoft True Type.

Этот популярный формат позволяет

удовлетворить практически любые ди�

зайнерские потребности.

Существует множество как платных,

так и бесплатных средств разработки

программ для КПК. Эти средства позво�

ляют разрабатывать программы на раз�

ных языках программирования, таких

как Ассемблер, Visual C, Visual Basic, Ford,

Perl и др.

Мощное средство разработки бесп�

латно предоставляет компания Micro�

soft на своём интернет�сайте [1]. Одна�

ко это средство довольно сложное и

требует установки на компьютер с опе�

рационной системой Windows XP гро�

моздких средств разработки Visual

Studio 2005 Professional и MSDN объё�

мом более 3 Гб, а также Windows Mobile

5.0 SDK объёмом 174 Мб и эмуляторов.

Описываемый здесь способ позволяет

обойтись установкой на компьютер

средства для разработки объёмом чуть

более 7 Мб. Это средство имеет название

Pelles C for Windows и свободно доступ�

но на сайте его разработчиков [2]. Прог�

раммы, созданные с его помощью, были

успешно протестированы автором на

КПК Pocket PC Loox N520 с операцион�

ной системой Windows Mobile 5.0.

Причём данное средство разработки

позволяет создавать разнообразные

программы не только для КПК, но и для

обычных стационарных персональных

компьютеров, а также для смартфонов и

коммуникаторов.

Данный пакет разработки включает в

себя интерфейс среды разработки IDE,

компилятор языка программирования

Си, заголовочные файлы и библиотеки

под разные платформы, набор полез�

ных утилит, примеры кода и встроен�

ный справочник среды разработки и

стандарта языка программирования

ISO C99. Пакет позволяет создавать

программы, работающие на стацио�

нарных персональных компьютерах с

операционными системами Windows

98/Me/NT4/2000/XP, а также на КПК,

коммуникаторах и смартфонах с разно�

видностями операционной системы

Windows CE.

Рассмотрим процесс установки и соз�

дания с его помощью разнообразных

программ для КПК.

Загрузив из Интернета файл про�

граммы с именем setup.exe [2], необхо�

димо запустить на выполнение эту

программу установки. После запуска

программы на экране монитора ком�

пьютера появится окно с текстом ли�

цензионного соглашения.

Для принятия данного соглашения

после его прочтения  необходимо уста�

новить флажок перед строкой 

I accept the terms in the license agree�

ments и щёлкнуть по программной

кнопке Next.

Далее программа установки отобра�

зит окно с сообщением о поддерживае�

мых средой разработки операционных

системах, рекомендациях использова�

ния программы и сведениях о месте на�

хождения примеров программ.

После ознакомления с предоставлен�

ной информацией необходимо щёлк�

нуть по программной кнопке Next для

продолжения.

В следующем окне предлагается уста�

новить некоторые параметры, опреде�

ляющие состав устанавливаемых фай�

лов среды разработки, поддержку наци�

ональных языков некоторых стран и ас�

социацию расширений файлов для ус�

танавливаемой среды.

Здесь следует оставить предложенные

установки и дополнительно установить

флажок перед строкой Pocket PC devel�

opment. После этого надо щёлкнуть по

программной кнопке Next.

В следующем окне будет указано место

предстоящей инсталляции пакета. По

умолчанию будет предложен каталог

C:\Program Files\PellesC. При желании

место установки пакета можно изме�

нить, отредактировав приведённую
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строку с именем каталога или используя

программную кнопку навигации Browse.

Далее следует щёлкнуть по програм�

мной кнопке Install для выполнения

процедуры инсталляции. После этого

начнётся процесс распаковки и записи

файлов программного пакета в указан�

ный каталог. Процесс установки можно

контролировать визуально, нажав прог�

раммную кнопку Show details в отобра�

жаемом окне программы установки.

После окончания установки всех фай�

лов будет отображено окно с сообщением

об успешной установке программы. Для

завершения установки следует нажать

программную кнопку Close в этом окне.

После этого программа установки пред�

ложит запустить среду разработки, отоб�

разив соответствующее окно сообщения.

Здесь можно согласится с запуском

программы, щёлкнув по программной

кнопке Да (Yes), или отказаться от не�

медленного запуска, щёлкнув по кнопке

Нет (No).

После установки программа среды

разработки Pelles C IDE будет находить�

ся в каталоге C:\Program Files\

PellesC\Bin\poide.exe.

Её можно запустить на выполнение в

любое время с помощью команды Пуск
→ Программы → Pelles C for Windows →
Pelles C IDE. Помимо среды разработки

можно вызвать справочные службы сре�

ды разработки или консольную оболоч�

ку программы Pelles C Command Promt.

После запуска среды разработки Pelles

C IDE на экране монитора появится ок�

но заставки программы.

Это окно исчезает через несколько се�

кунд самостоятельно, а также принуди�

тельно после щелчка по нему левой

кнопкой мыши.

Под этим окном располагается среда

разработки, имеющая привычный ин�

терфейс программ для Windows.

Рассмотрим пример создания прог�

раммы, демонстрирующий работу в

данной среде разработки и позволяю�

щий быстро научиться разрабатывать

собственные программы для КПК и

смартфонов.

В качестве такого примера создадим

программу, которая позволит произво�

дить вычисления по конвертированию

рублей в валюту других стран, а именно в

доллары США и в евро. Данный пример

программы позволит продемонстриро�

вать создание диалоговых программ для

КПК с операциями ввода чисел, вычисле�

ний над ними и отображения результатов.

Итак, после запуска среды разработки

Pelles C IDE последовательно выберите в

главном меню интерфейса среды ко�

манды File → New → Project, как это по�

казано на рис. 1. После этого на экране

компьютера отобразится окно мастера

новых проектов (рис. 2).

С помощью данного мастера можно

создавать заготовки программ различ�

ного назначения для разных операци�

онных систем. Вид отображения иконок

программных приложений данного ок�

на можно изменять с помощью двух

программных кнопок, расположенных

в верхней правой части окна.

Выделите в этом окне программное

приложение мастера с названием Po�

cket PC application wizard. В строке с за�

головком Name введите имя нового

проекта с названием exchange и щёлк�

ните по программной кнопке OK.

В следующем открывшемся окне мас�

тера приложений отредактируйте имя

будущей программы, удалив в предло�

женном названии exchange Program

слово Program и оставив только имя

exchange.

Ниже имени программы предлагается

выбрать тип проекта.

Первый из этих типов позволит соз�

дать заготовку программы простейшего

приложения.

Второй тип проекта создаёт знакомую

многим программу, которая при запуске

на КПК отображает сообщение Hello,

world! («Здравствуй, мир!»). В будущем

можно будет создать любой из предлага�

емых типов для самостоятельного изу�

чения создаваемых проектов.

Для нашей программы среди предлага�

емых типов проекта следует выбрать тип

A dialog based program. После этого следу�

ет нажать программную кнопку «Далее».

В последнем окне мастера приложе�

ний выводится сообщение о том, какие

файлы были созданы в процессе его ра�

боты и в каком каталоге они находятся.

Для завершения работы мастера при�

ложений в этом окне следует нажать

программную кнопку «Готово». После

этого в правой части окна среды разра�

ботки отобразится состав созданного

проекта в виде структуры каталога и пе�

речня файлов с иконками (рис. 3).

Познакомиться с основными поняти�

ями проектов для Windows можно в [3].

Для редактирования ресурсов

программы дважды щёлкните по

иконке с именем файла main.rc. При

этом в левой части окна среды разра�

ботки отобразится раскрывающийся

состав данного файла (рис. 4).

Здесь необходимо дважды щёлкнуть

по названию файла DLG_MAIN для раск�

рытия его содержимого и последующе�

го редактирования. При этом откроется

окно для редактирования данного ре�

сурса. Для удобства редактирования

раскройте и расположите элементы

данного окна по своему вкусу.

Используя палитру компонентов, по�

местите на окно главной формы прог�

раммы три компонента Editbox, семь

компонентов Text и два компонента

кнопок Pushbutton, как это показано на

рис. 5.

Теперь необходимо изменить свой�

ства Name и Text помещённых на фор�

му программы компонентов. Для этого

необходимо щёлкнуть по компоненту,

чьи свойства подлежат редактирова�

нию, а затем дважды щёлкнуть в окне

свойств по строке, подлежащей редак�

тированию, и ввести новые значения.

Например, для кнопки OK следует заме�

нить в свойстве Text слово OK на слово

«Выход». Для остальных компонентов

необходимо произвести изменения

свойств в соответствии с таблицей. Это

позволит инициализировать начальные

значения, сформировать осмысленное

содержание формы программы и ис�

пользовать в программе заданные име�

на компонентов для обращения к ним.

В результате такого редактирования

должно получиться окно формы.
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Рис. 1.  Выбор нового проекта

Рис. 2.  Окно мастера новых проектов



Теперь можно выполнить трансля�

цию программы с помощью команд ме�

ню Project → Build или нажав на клавиа�

туре компьютера клавиши Ctrl и B.

При успешной трансляции в окне со�

общений, расположенном внизу интер�

фейса разработки, должны последова�

тельно появиться строки сообщений:

Building main.obj

Building main.res

Building exchange.exe

Done

При этом средой разработки будет

создан исполняемый код программы

exchange.exe и код программы main.c.

Код программы можно просмотреть и

отредактировать, щёлкнув дважды по

имени файла main.c в правом окне сре�

ды разработки. При этом откроется ок�

но редактирования кода, текст которо�

го приведён в файле Листинг 1 в до�

полнительных материалах к статье на

сайте журнала.

Вставьте в текст этой программы пос�

ле строки #include «main.h» строку ком�

ментария и две строки макроопределе�

ний, которые будут использоваться в

программе:

/* Пользовательские макроопреде�

ления */

#define NELEMS(a)  (sizeof(a) /

sizeof((a)[0]))

#define

SetDlgItemFocus(hwnd,idCtl) FOR�

WARD_WM_NEXTDLGCTL((hwnd),

GetDlgItem((hwnd),(idCtl)), TRUE,

PostMessage)

После строки комментария /* TODO:

Add more control ID’s, when needed.*/,

предлагающей ввести код программы

для обработки дополнительных кнопок

программы, введите текстовые строки

программы из файла Листинг 2, приве�

дённого на сайте журнала.

Данный листинг снабжён коммента�

риями, поясняющими действия, кото�

рые выполняются программой, обраба�

тывающей ввод данных, нажатие прог�

раммных кнопок и отображение резуль�

тата вычислений.

На этом редактирование программы

заканчивается, и можно выполнить её

окончательную трансляцию, нажав кла�

виши Ctrl и B.

После успешной трансляции про�

граммы загрузите файл с её исполняе�

мым кодом, имеющим имя exchange.exe,

в КПК и запустите в нем эту программу.

Для загрузки программы в КПК исполь�

зуется специальный загрузочный ка�

бель связи КПК с персональным компь�

ютером и программа ActiveSync, постав�

ляемые в комплекте с КПК.

После запуска программы на КПК вве�

дите в поле «Рубли» с помощью цифро�

вых клавиш сенсорной виртуальной

клавиатуры произвольную сумму и

щёлкните стилусом по кнопке «Обмен».

При этом программа произведёт вычис�

ления и отобразит под словом «Сумма»

количество долларов и евро, которые

можно обменять на введённую сумму

рублей.

Окно копии работы программы КПК

можно получить с помощью самой сре�

ды разработки. Для этого необходимо

выполнить команды главного меню ин�

терфейса разработки Tools → Capture

Screen from Pocket PC и в открывшемся

окне программы выполнить команды

File → New bitmap.

Как было сказано вначале, среда раз�

работки позволяет создавать програм�

мы не только для КПК, но и для смарт�

фонов с операционной системой

Windows CE или Windows Mobile. Прин�

ципиальных отличий в разработке

программ для этих устройств нет. Необ�

ходимо лишь при создании проекта ис�

пользовать соответствующий мастер

проектов для смартфона.

Помимо основных средств для прог�

раммирования, среда разработки пре�

доставляет разработчику встроенные

редакторы ресурсов программы, позво�

ляющие создавать иконки и другие ри�

сунки, файлы разных форматов и про�

чие объекты, используемые разрабаты�

ваемой программой.

Аналогично рассмотренному приме�

ру можно создавать различные прог�

раммы специального назначения для

решения возникающих задач с по�

мощью КПК или смартфона.
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Рис. 4. Левая часть окна среды разработки

Рис. 5. Окно главной формы программы

Таблица 1. Новые свойства компонентов программы

Компонент
Свойство

Text Name

Text Курс Не изменять

Text Сумма Не изменять

Text Доллар США Не изменять

Text Евро Не изменять

Text Рубли Не изменять

Text 0 IDTEXT1

Text 0 IDTEXT2

Editbox 26.5 IDEDIT1

Editbox 34.5 IDEDIT2

Editbox 0 IDEDIT3

Pushbutton Обмен IDRUN

Pushbutton Сброс IDINIT

Рис. 3. Структура каталога и перечень файлов

с иконками


